Kernel for Windows Data Recovery

Successfully Recovers Data from Formatted or corrupt FAT & NTFS Partitions

PRODUCT GUIDE
# Table of Contents

1. Introduction to Kernel for Windows Data Recovery .................................................................................. 5
   1.1 Using this Manual ................................................................................................................................. 5
   1.2 About Kernel for Windows Data Recovery .......................................................................................... 6
   1.3 Salient Features .................................................................................................................................. 7
   1.4 Who Should Use this Software? ........................................................................................................... 8
   1.5 System Requirements ............................................................................................................................ 9

2. Install and Uninstall .................................................................................................................................. 10
   2.1 Install Kernel for Windows Data Recovery ........................................................................................... 10
   2.2 Uninstall Kernel for Windows Data Recovery ....................................................................................... 10

3. Understanding the User Interface ............................................................................................................ 12
   3.1 Menu bar .............................................................................................................................................. 12
   3.2 Toolbar ............................................................................................................................................... 15
   3.3 Buttons Used ....................................................................................................................................... 17

4. Using Kernel for Windows Data Recovery ............................................................................................... 18
   4.1 Recover Data from Physical Devices ..................................................................................................... 18
   4.2 Recover Data from Logical Drives ........................................................................................................ 30
   4.3 Preview Recovered Files ...................................................................................................................... 35

5. Understanding Other Useful Options ....................................................................................................... 36
   5.1 Configure Software Settings ................................................................................................................ 37
   5.2 Save Snapshot .................................................................................................................................... 37
   5.3 Load Snapshot ................................................................................................................................... 38
   5.4 Find File(s) ........................................................................................................................................ 39
   5.5 File Filters .......................................................................................................................................... 40
   5.6 Drive Information ................................................................................................................................. 41

6. Download Purchase and Register ........................................................................................................... 42
   6.1 Free Trial Download ............................................................................................................................ 42
   6.2 Purchase and Register .......................................................................................................................... 42
   6.3 Support .............................................................................................................................................. 43

7. Legal Notices ........................................................................................................................................... 44
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.1</td>
<td>Copyright Notice</td>
<td>44</td>
</tr>
<tr>
<td>7.2</td>
<td>Trademarks</td>
<td>44</td>
</tr>
<tr>
<td>7.3</td>
<td>Disclaimer</td>
<td>44</td>
</tr>
<tr>
<td>7.4</td>
<td>License Agreement</td>
<td>44</td>
</tr>
</tbody>
</table>
## Table of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1</td>
<td>Recovery Menu</td>
<td>12</td>
</tr>
<tr>
<td>3.2</td>
<td>View Menu</td>
<td>13</td>
</tr>
<tr>
<td>3.3</td>
<td>Tools Menu</td>
<td>14</td>
</tr>
<tr>
<td>3.4</td>
<td>Help Menu</td>
<td>15</td>
</tr>
<tr>
<td>4.1</td>
<td>Main Window</td>
<td>19</td>
</tr>
<tr>
<td>4.2</td>
<td>Quick Scan Window</td>
<td>20</td>
</tr>
<tr>
<td>4.3</td>
<td>Quick Scan Continuation Window</td>
<td>20</td>
</tr>
<tr>
<td>4.4</td>
<td>Select Partition Window</td>
<td>21</td>
</tr>
<tr>
<td>4.5</td>
<td>Partition Configuration Window</td>
<td>22</td>
</tr>
<tr>
<td>4.6</td>
<td>Searching Data Window</td>
<td>23</td>
</tr>
<tr>
<td>4.7</td>
<td>Recovered Data Window</td>
<td>24</td>
</tr>
<tr>
<td>4.8</td>
<td>Preview Data Window</td>
<td>25</td>
</tr>
<tr>
<td>4.9</td>
<td>Browse for Folder Window</td>
<td>25</td>
</tr>
<tr>
<td>4.10</td>
<td>Saving the Selected item Window</td>
<td>26</td>
</tr>
<tr>
<td>4.11</td>
<td>Successful Completion of Saving Data Window</td>
<td>26</td>
</tr>
<tr>
<td>4.12</td>
<td>Partition Selection Window</td>
<td>29</td>
</tr>
<tr>
<td>4.13</td>
<td>Logical Drive Recovery Window</td>
<td>31</td>
</tr>
<tr>
<td>4.14</td>
<td>File Trace Window</td>
<td>34</td>
</tr>
<tr>
<td>4.15</td>
<td>File Type Preview</td>
<td>36</td>
</tr>
<tr>
<td>5.1</td>
<td>Recovery Setting Window</td>
<td>37</td>
</tr>
<tr>
<td>5.2</td>
<td>Save As Window</td>
<td>38</td>
</tr>
<tr>
<td>5.3</td>
<td>Open Dialog Box Window</td>
<td>39</td>
</tr>
<tr>
<td>5.4</td>
<td>Find Files Window</td>
<td>40</td>
</tr>
<tr>
<td>5.5</td>
<td>File Filter Dialog Box</td>
<td>41</td>
</tr>
<tr>
<td>5.6</td>
<td>Drive Information Window</td>
<td>41</td>
</tr>
</tbody>
</table>
1. Introduction to Kernel for Windows Data Recovery

Welcome to the user manual of Kernel for Windows Data Recovery, the most effective and easy-to-use data recovery software that helps you to recover data from lost, deleted, formatted and corrupted partitions where FAT and NTFS based operating system, such as Windows 95, Windows ME, Windows 98, Windows NT, Windows 2000, Windows 2003, Windows XP, Windows Vista, Windows 7, and Windows 8 are installed on the hard disk or data storage media. This user manual comprises step-by-step guidelines on using Kernel for Windows Data Recovery.

1.1 Using this Manual

This user manual is intended to guide users on using Kernel for Windows Data Recovery. We suggest that first time users should read this user manual completely and carefully before proceeding to use the software. However, if you are an experienced user, you can use the table of contents to find out information pertaining to the tasks that you need to perform by using Kernel for Windows Data Recovery.

You can use the table of contents to navigate through different sections of this user manual. The table of contents lists all the sections that are contained in this user manual in chronological order. The user manual comprises the following sections:

- Introduction
- Getting Started
- Software Interface
- Recovering Windows Data
- Full Version
- Support
- Troubleshooting
- Legal Notice

Certain abbreviations have been used throughout this manual. For clear understanding of the contents of this user manual, please go through the list of abbreviations, mentioned below, before reading the manual.

1.1.1 List of Abbreviations

FAT: File Allocation Table
NTFS: New Technology File System
RAM: Random Access Memory
MB: Mega-Byte

© Lepide Software Private Limited
1.2 About Kernel for Windows Data Recovery

Kernel for Windows Data Recovery is an effective, stupendous, and result-oriented FAT and NTFS data recovery software. The software effectively recovers data from the corrupt, damaged, or virus-attacked FAT16, FAT32, NTFS, and NTFS5 partitions. The software confirms an assured recovery of lost data. The data, which has been deleted from the Recycle Bin or using SHIFT + DELETE key can also be recovered with Kernel for Windows Data Recovery software. Following are the reasons that generally lead into data loss:

- Accidental or intentional formatting of hard disk partitions
- Accidental file deletion
- Virus attack
- Corruption of hard disk partition(s)
- Damage or deletion of partition structures
- Unexpected system shutdown
- Software failure
- Corruption of Windows file system(s)
- Accidental or intentional deletion of data stored on hard disk

The software is equipped with three recovery modes: Quick Scan, Extensive Scan, and File Trace. These recovery modes enable the user to recover the lost data based on the various data loss situations. Kernel for Windows Data Recovery software maintains the logical structure, formatting, and properties of the recovered files and folders. While recovering the lost files, the software arranges them in their respective folders. In case, the parent folder of the recovered files is not found then the software creates a folder named Lost Dir and saves the recovered individual files in that folder.

With Kernel for Windows Data Recovery software, a user can impeccably recover data from existing logical drives and the hard disk partitions, as well. In some cases, it may happen that you do not see the hard disk partition from which you want to recover the lost data. At that time, you can use the Search Partition option of the software to locate the missing partition to continue the data recovery. Brief about the available data recovery modes in Kernel for Windows Data Recovery software is given below:

**Quick Scan** is a fast recovery mode, which assures data recovery of deleted files, files lost due to bad sectors, boot sector corruptions, FAT corruptions, index corruptions, partition deletions, MFT corruptions, virus attacks, media errors, etc. The recently deleted file(s) are effectively recovered by this mode of recovery.

**Extensive Scan** is an advanced recovery mode, which recovers data lost due to partition format, partition deletion, and re-formatting of hard disk partitions. This mode should be selected when you want to recover
the files and folders that were deleted long time ago. You can also select this mode when the Quick Scan mode does not recover the desired files and folders.

**File Trace** is a slow but effective recovery mode, which extensively scans the corrupt partition or drive to recover data from it. This recovery mode takes time in data recovery as it searches for lost data in sectors of the drive and then lists them to you. This mode enables you to search for specific file types to speed up the recovery process. For example, if you want to recover only .doc files then the software will only search for .doc files on the selected hard disk partition or logical drive.

The **File Trace** mode should be selected when **Quick Scan** and **Extensive Scan** modes are unable to recover the lost data.

### 1.3 Salient Features

Kernel for Windows Data Recovery software incorporates a myriad of outstanding features that make data recovery simple and effective. Following are the software features:

- Recovers data from Physical device as well as Logical device.
- Recovers the data lost due to corruption, formatting, or re-formatting of the hard disk partitions.
- Recovers all types of files, such as images, video files, music files, database files, email files, media files, archive files, and graphic files.
- Comprises three recovery modes: Quick Scan, Extensive Scan, and File Trace to help you recover data based on various data loss situations:
  - **Quick Scan**: This is the fastest recovery mode, which helps you recover the files and folders that are deleted recently. This mode can also be used in case the data is lost due to damage of MFT, corruption of the file system(s), presence of bad sectors on disk, and Index corruption.
  - **Extensive Scan**: This mode is comparatively slower than the Quick Scan mode. Using this mode, you can recover those files and folders that Quick Scan mode fails to recover. The mode works well in case the data is lost due to hard disk formatting, deletion of hard disk partitions, and recreation of hard disk partitions.
  - **File Trace**: It is the slowest but the most efficient data recovery mode of the software. The mode scans the complete hard disk drive sector by sector to recover the maximum data. One should use this mode when both Quick Scan and Extensive Scan modes get failed to produce the desired result. Using this mode, the user can even recover the files that were deleted long back.
- Displays the recovered folders in a tree-like structure to ease the search process.
- Displays the deleted files (that are now recovered) in Red color for their quick identification.
- Comprises Find Files option that helps you search for a specific type of files in the recovered data.
- Enables you to preview the recovered files before saving.
Comprises the Save Snapshot and Load Snapshot features that help you save the recoverable data as a snapshot. The saved snapshot can be loaded anytime using the Load Snapshot option to continue the recovery process. The Save Snapshot and Load Snapshot features are beneficial when you do not have much time to sit and wait for the recovery process to finish. You can save the recoverable data on your computer's hard disk and later on by loading the snapshot you can move ahead with the recovery process.

 Enables you to configure software settings based on which the software will recover the lost data. Settings that can be configured are:

- Sectors to be read in one attempt
- Rename, overwrite, or skip the duplicate files
- Include deleted files in the search, exclude deleted files from recovered files, or only recover the deleted files
- Number of retries on bad sectors

 Provides full support for long file names.

 Supports all types of drives, such as IDE, EIDE, SCSI, SATA, PEN, ZIP, and USB drives.

 Recovers data from the drives that appear as Logical Drive in your computer.

 Provides full support to FAT 16, FAT 32, NTFS, and NTFS5 file systems.


 Round the clock technical support.

1.4 Who Should Use this Software?

The capability and potential of Kernel for Windows Data Recovery to recover deleted, damaged and formatted windows hard drive partition make it appropriate for every condition. Previously, the hard drive recovery was manually performed by professionals or experienced user.

Now with Kernel for Windows Data Recovery, any inexperienced or home user can easily use it to recover the data from the corrupt, formatted and deleted partitions which leads to data loss scenarios. The data loss scenarios could have been caused due to accidental file deletion, file system corruption, operating system corruption, erroneous hard drive format operations and other logical problems to your computer system.
1.5 System Requirements

Before you start installing Kernel for Windows Data Recovery software, make sure that your computer meets the following system requirements:

**Basic System Requirements**

- Pentium Class Processor
- 64 MB RAM (128 MB Recommended)
- 10 MB of free disk space for software installation

**Supported Windows OS Platforms**

- Windows Server 2012
- Windows Server 2008
- Windows 8
- Windows 7
- Windows Vista
- Windows XP
- Windows 2003
- Windows 2000
- Windows NT
- Windows 98
- Windows ME
- Windows 95

**Supported File Systems**

- FAT 16
- FAT 32
- NTFS
- NTFS 5
2. Install and Uninstall

After checking your computer with the prescribed system requirements for Kernel for Windows Data Recovery, you can download and install this software on your computer.

2.1 Install Kernel for Windows Data Recovery

After being familiar with the software overview, key features, and system requirements let us install the software. However, before installing the software you must ensure that the software installer file is available on your computer. If the file is not available on your computer then you can download the file from our Website- http://www.nucleustechnologies.com/Data-Recovery-Software.html.

After you have downloaded the installer file, execute the following steps to install the software:

- Double-click the installer file of **Kernel for Windows Data Recovery** software.
- Follow the on-screen instructions. When the installation process completes “Setup Installation Complete” message appears on the software installation screen.
- Click the **Finish** button to launch the software.

2.2 Uninstall Kernel for Windows Data Recovery

You can uninstall the Kernel for Windows Data Recovery software from your computer system by using one of the following two methods:

- Uninstall from Windows Start Menu
- Uninstall from Control Panel

(Note: Before starting the uninstallation process, make sure that the Kernel for Windows Data Recovery software is not in use.)
2.2.1 Uninstall from the Windows Start menu

Execute the following steps to uninstall Kernel for Windows Data Recovery from Windows Start menu:

1. Click Start > All Programs > Kernel for Windows Data Recovery > Uninstall Kernel for Windows Data Recovery. A warning message before uninstalling the software will be displayed on the screen.

2. Click the Yes button to uninstall the software.

3. Click the OK button.

Kernel for Windows Data Recovery is successfully uninstalled from your computer system.

2.2.2 Uninstall from Control Panel

Execute the following steps to uninstall Kernel for Windows Data Recovery from Control Panel:

1. Click Start > Control Panel. The Control Panel window appears.

2. Double-click the Add or Remove Programs icon. A list of the programs installed on your computer appears.

3. Select Kernel for Windows Data Recovery and click the Remove button. A warning message before uninstalling the software will be displayed on the screen.

4. Click the Yes button to uninstall the software.

5. Click the OK button.

Kernel for Windows Data Recovery is successfully uninstalled from your computer system.
3. Understanding the User Interface

Now that Kernel for Windows Data Recovery has been installed on your computer, you can start using the software after getting acquainted with the software interface.

3.1 Menu bar

The Menu bar of Kernel for Windows Data Recovery comprises following main menus:

- Recovery Menu
- View Menu
- Tools Menu
- Help Menu

3.1.1 Recovery Menu

Recovery menu of the Kernel for Windows Data Recovery software appears, as shown in following figure:

![Recovery Menu](image)

**Figure 3.1: Recovery Menu**

Following table enlists the options available in the Recovery menu:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recover Selected</td>
<td>Select this option to start the process of saving the recoverable data.</td>
</tr>
<tr>
<td>Save Recovery Snapshot</td>
<td>Select this option to save the recoverable data as snapshot when you do not have time to sit and wait for the data to be saved on your computer’s hard disk or another storage media.</td>
</tr>
<tr>
<td>Load Recovery Snapshot</td>
<td>Select this option to load the saved snapshot.</td>
</tr>
</tbody>
</table>
Exit

Select this option to close the software.

### 3.1.2 View Menu

The View menu allows you to change the pattern of viewing the recovered file(s) in the software. View menu of the Kernel for Windows Data Recovery software appears, as shown in following figure:

![View Menu](image)

**Figure 3.2: View Menu**

Following table enlists the options available in the View menu:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Icons</td>
<td>Select this option to view the recovered files in form of icons.</td>
</tr>
<tr>
<td>List</td>
<td>Select this option to view the recovered files in a list-like structure.</td>
</tr>
<tr>
<td>Details</td>
<td>Select this option to view the recovered files with complete details like size, type, date, etc.</td>
</tr>
</tbody>
</table>

### 3.1.3 Tools Menu

Tools menu of the Kernel for Windows Data Recovery software appears, as shown in following figure:
Following table enlists the options available in the **Tools** menu:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find Files</td>
<td>Select this option to find specific file(s) from the recovered file(s). For example, you need to view .xls files then type *.xls in “Find Files” dialog box and the software will display all the MS Excel file(s) amongst the recovered files.</td>
</tr>
<tr>
<td>File Filters</td>
<td>This option works similar to the <strong>Find Files</strong> option. However, the only difference among both is using the <strong>Find Files</strong> option, you can search for a specific type of files, say *.xls but with the <strong>File Filters</strong> option, you can specify multiple file types, say *.xls, *.docx, *.pdf, etc. Based on the file type(s) you specify, the software displays the recovered items.</td>
</tr>
<tr>
<td>Settings</td>
<td>Select this option to configure following software settings based on which the software will search the lost files and folders:</td>
</tr>
<tr>
<td></td>
<td>• Sectors to be read in one attempt</td>
</tr>
<tr>
<td></td>
<td>• Rename, overwrite, or skip the duplicate files</td>
</tr>
<tr>
<td></td>
<td>• Include deleted files in the search, exclude deleted files from recovered files, or only recover the deleted files</td>
</tr>
<tr>
<td></td>
<td>• Number of retries on bad sectors</td>
</tr>
</tbody>
</table>
3.1.4 Help Menu

Help menu of the Kernel for Windows Data Recovery software appears, as shown in following figure:

![Help Menu]

Figure 3.4: Help Menu

Following table enlists the options available in the Help menu:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help</td>
<td>Select this option to view Help manual of the software.</td>
</tr>
<tr>
<td>Buy Online</td>
<td>Select this option to purchase the software online</td>
</tr>
<tr>
<td>About Kernel for Windows Data Recovery</td>
<td>Select this option to view software version information and support details of the software.</td>
</tr>
<tr>
<td>Activate Now</td>
<td>Select this option to activate the software.</td>
</tr>
</tbody>
</table>

3.2 Toolbar
Tool bar consists of buttons that work as shortcuts for various options available in the main menus of Kernel for Windows Data Recovery software. Following table enlists the buttons available on the Tool bar of the software:

<table>
<thead>
<tr>
<th>Button</th>
<th>Button Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Recover" /></td>
<td>Recover</td>
<td>Click this button to start the saving process.</td>
</tr>
<tr>
<td><img src="image2" alt="Save Snapshot" /></td>
<td>Save Snapshot</td>
<td>Click this button to save the recovery snapshot.</td>
</tr>
<tr>
<td><img src="image3" alt="Load Snapshot" /></td>
<td>Load Snapshot</td>
<td>Click this button to load the recovery snapshot.</td>
</tr>
<tr>
<td><img src="image4" alt="Find" /></td>
<td>Find</td>
<td>Click this button to enter and search specific file types amongst thousands of file(s) recovered by the software.</td>
</tr>
<tr>
<td><img src="image5" alt="Setting" /></td>
<td>Setting</td>
<td>Click this button to view and modify following software settings based on which the software will search the lost files and folders:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Sectors to be read in one attempt</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Rename, overwrite, or skip the duplicate files</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Include deleted files in the search, exclude deleted files from recovered files, or only recover the deleted files</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Number of retries on bad sectors</td>
</tr>
</tbody>
</table>
3.3 Buttons Used

There are several buttons used in the software that helps you throughout the recovery process. Following table lists the buttons used in the software:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Recover" /></td>
<td>Click this button to start the saving process.</td>
</tr>
<tr>
<td><img src="image" alt="Hide Progress" /></td>
<td>Click this button to hide the searching process. While searching for the files and folders on the selected hard disk partition or logical disk drive, the software displays the progress. If you do not want to see that progress then just click the “Hide Progress” button. Clicking the “Hide Progress” button also improves the recovery speed.</td>
</tr>
<tr>
<td><img src="image" alt="Show Progress" /></td>
<td>Click this button to view the searching progress.</td>
</tr>
<tr>
<td><img src="image" alt="Next" /></td>
<td>Click this button to proceed to next step during the recovery process.</td>
</tr>
<tr>
<td><img src="image" alt="Back" /></td>
<td>Click this button to navigate back during the recovery process.</td>
</tr>
<tr>
<td><img src="image" alt="Stop" /></td>
<td>Click this button to stop the searching or saving process in-between.</td>
</tr>
</tbody>
</table>
4. Using Kernel for Windows Data Recovery

Now that you have got familiar with the user interface of Kernel for Windows Data Recovery, you are ready to recover Windows data from physical devices and logical drives.

4.1 Recover Data from Physical Devices

Whether you have one hard disk in your computer or two, Kernel for Windows Data Recovery software enables you to recover the lost data from all hard disk attached to the computer. Whatever is the reason behind the data loss be it hard disk formatting, OS corruption, or accidental files deletion, Kernel for Windows Data Recovery thoroughly scans the selected hard disk to provide you with the recovered data. The software provides you following modes to recover the lost data from hard disk:

- Quick Scan
- Extensive Scan
- File Trace

4.1.1 Using the Quick Scan Mode

The Quick Scan mode is the fastest mode of data recovery. It enables you to recover the recently deleted files and folders, data lost due to recent formatting of hard disk partitions, etc. Execute the following steps to recover the lost data using the Quick Scan Mode:

1. Select Start > All Programs > Kernel for Windows Data Recovery > Kernel for Windows Data Recovery to launch the software. The software home Window appears providing you an overview about the available recovery modes:
2. Click the **Quick Scan** icon. All Physical Device(s) and Logical Drive(s) available in your computer appear.

3. Select a Hard Disk under the Physical Devices node from which you want to recover the data. When you select the Hard Disk, information, such as Model number of the hard disk, capacity of the hard disk, partition types, etc. appears:
4. Click the **Next** button to move ahead in the recovery process. The “Please Select” dialog box appears:

![Figure 4.3: Quick Scan Continuation Window](image)

Select the **Use existing partition info** radio button to recover the data from an existing partition on the selected hard disk. If you cannot see the partition in the hard disk then select the **Search partition** radio button to search the lost hard disk partition.
5. Select an appropriate option and click the **OK** button. On selecting the appropriate option, the software lists the available partitions in the left panel:

![Select Partition Window](image)

Figure 4.4: Select Partition Window

6. Select a partition. The software displays the partition configuration:
7. Click the **Next** button. The software starts searching for the recoverable data:
Click the **Hide Progress** button to improve the performance of data searching and hide the progress information.

Click the **Stop** button to stop the searching process anytime.

After the searching process is completed, a dialog box prompting you to use the “**Extensive Scan**” mode (if you do not find the desired result) appears.

8. Click the **OK** button to close the dialog box. All recoverable files are displayed in a tree-like structure in the left panel of the software window:
9. Select a folder in the left tree whose content you want to verify before saving. When you select the folder, its content will be displayed in the right panel.

10. Now, select an item in the right panel to preview the selected item. The software displays the preview of the selected item:
11. After previewing the required items, select them for saving and then click the **Recover** button. The "Browse for Folder" dialog box appears:
12. Specify a location to save the selected items and then click the OK button. The software starts saving the selected items at the specified location:

![Figure 4.10: Saving the Selected item Window](image)

**Note:** You can stop the saving process by clicking the Stop Saving button or if you want to skip any file from saving, click the Skip File button.

After the saving process is completed, a dialog box displaying the "Files Saved Successfully" message appears:

![Figure 4.11: Successful Completion of Saving Data Window](image)

13. Click the OK button to close the dialog box.

Now, you can view the recovered file(s) from the saved location.

### 4.1.2 Using the Extensive Scan Mode

The Extensive Scan mode allows you to recover data from the formatted, corrupt, deleted, or recreated partitions. This mode is slower than the Quick Scan mode; therefore, it should be used when you do not get satisfactory output from the Quick Scan mode. Following steps help you to recover data using the Extensive Scan mode:

1. Start the software.
2. Click the **Extensive Scan** icon. All Physical Device(s) and Logical Drive(s) available in your computer appear.

3. Select a Hard Disk under the Physical Devices node from which you want to recover the data. When you select the Hard Disk, information, such as Model number of the hard disk, capacity of the hard disk, partition types, etc. appears in the right panel.

4. Click the **Next** button to move ahead in the recovery process. The “**Please Select**” dialog box appears. Select the “**Use existing partition info**” radio button to recover the data from an existing partition on the selected hard disk. If you cannot see the partition in the hard disk then select the “**Search partition**” radio button to search the lost hard disk partition.

5. Select an appropriate option and click the **OK** button. On selecting the appropriate option, the software lists the available partitions in the left panel.

6. Select a partition. The software displays the partition configuration and also allows you to change the file system of the selected partition. You can change the file system by clicking the drop-down arrow beside the “**Select File System**” drop-down list.

7. Click the **Next** button. The software starts searching for the recoverable data.

   **Note:**
   
   1. Click the **Hide Progress** button to improve the performance of data searching and hide the progress information.
   
   2. Click the **Stop** button to stop the searching process anytime.

After the searching process is completed, all recoverable files are displayed in a tree-like structure in the left panel of the software window.

8. Select a folder in the left tree whose content you want to verify before saving. When you select the folder, its content will get displayed in the right panel.

9. Now, select an item in the right panel to preview the selected item. The software displays the preview of the selected item.

10. After previewing the required items, select them for saving and then click the **Recover** button. The “**Browse for Folder**” dialog box appears.

11. Specify a location to save the selected items and then click the **OK** button. The software starts saving the selected items at the specified location.

   **Note:** You can stop the saving process by clicking the **Stop Saving** button or if you want to skip any file from saving, click the **Skip File** button.
After the saving process is completed, a dialog box displaying the “Files Saved Successfully” message appears.

12. Click the OK button to close the dialog box.

Now, you can view the recovered file(s) from the saved location.

4.1.3 Using the File Trace Mode

It is the slowest mode of data recovery. This mode scans the hard disk partition sector by sector to recover the maximum data. Following steps help you to recover data using the Extensive Scan mode:

1. Start the software.

2. Click the File Trace icon. All Physical Device(s) and Logical Derive(s) available in your computer appear.

3. Select a Hard Disk under the Physical Devices node from which you want to recover the data. When you select the Hard Disk, information, such as Model number of the hard disk, capacity of the hard disk, partition types, etc. appears in the right panel.

4. Click the Next button to move ahead in the recovery process. The “Please Select” dialog box appears. Select the “Use existing partition info” radio button to recover the data from an existing partition on the selected hard disk. If you cannot see the partition in the hard disk then select the “Search partition” radio button to search the lost hard disk partition.

5. Select an appropriate option and click the OK button. On selecting the appropriate option, the software lists the available partitions in the left panel.

6. Select a partition. The “File Types” dialog box appears:
7. Select the file types that you want to recover and click OK to continue with the data searching process.

8. As you click the OK button the software starts searching for the recoverable data.

   **Note:**

   - Click the **Hide Progress** button to improve the performance of data searching and hide the progress information.
   - Click the **Stop** button to stop the searching process anytime.

After the searching process is completed, all recoverable files are displayed in a tree-like structure in the left panel of the software window.

9. Select a folder in the left tree whose content you want to verify before saving. When you select the folder, its content will be displayed in the right panel.

10. Now, select an item in the right panel to preview the selected item. The software displays the preview of the selected item.

11. After previewing the required items, select them for saving and then click the **Recover** button. The “**Browse for Folder**” dialog box appears.
12. Specify a location to save the selected items and then click the **OK** button. The software starts saving the selected items at the specified location.

![Note:](image)

**Note:** You can stop the saving process by clicking the **Stop Saving** button or if you want to skip any file from saving, click the **Skip File** button.

After the saving process is completed, a dialog box displaying the “Files Saved Successfully” message appears.

13. Click the **OK** button to close the dialog box.

Now, you can view the recovered file(s) from the saved location.

![Note:](image)

**Note:** In this mode, deleted files are not displayed in Red color. Moreover, original file names are not recovered; therefore, files are named numerically in a proper sequence.

### 4.2 Recover Data from Logical Drives

Apart from enabling you to recover data from physical devices attached to the computer, Kernel for Windows Data Recovery software allows you to recover data from the logical drives appearing in your computer. During the recovery process, Kernel for Windows Data Recovery thoroughly scans the selected drive to provide you with the recovered data. The software provides you following modes to recover the lost data from selected logical drive:

- **Quick Scan**
- **Extensive Scan**
- **File Trace**

#### 4.2.1 Using the Quick Scan Mode

**Quick Scan** is fast and accurate data recovery mode that proves to be helpful in recovering recently deleted files, files affected due to bad sectors, FAT corruptions, Index corruptions, MFT corruptions, system files get corrupt, and if the partition gets deleted. This mode is fast in scanning and searching your corrupt hard drive for data. The recovery method displays the recovered files and folders in a tree-like structure from where you can preview selected files. Execute the following steps to recover data using **Quick Scan** mode:

1. Start the software.

2. Click the **Quick Scan** icon. All Physical Device(s) and Logical Drive(s) available in your computer appear.
3. Select a drive under the Logical Devices node from which you want to recover the data. When you select the drive, information, such as volume name, capacity, etc. appears in the right panel:

![Image of Logical Drive Recovery Window]

Figure 4.13: Logical Drive Recovery Window

4. Click the **Next** button to move ahead in the recovery process.

5. Again click the **Next** button.

6. The software starts searching for the recoverable data.

   **Note:**

   - Click the **Hide Progress** button to improve the performance of data searching and hide the progress information.
   - Click the **Stop** button to stop the searching process anytime.

After the searching process is completed, a dialog box prompting you to use the “Extensive Scan” mode (if you do not find the desired result) appears.
7. Click the OK button to close the dialog box. All recoverable files get displayed in a tree-like structure in the left panel of the software window.

8. Select a folder in the left tree whose content you want to verify before saving. When you select the folder, its content will be displayed in the right panel.

9. Now, select an item in the right panel to preview the selected item. The software displays the preview of the selected item.

10. After previewing the required items, select them for saving and then click the button. The “Browse for Folder” dialog box appears.

11. Specify a location to save the selected items and then click the OK button. The software starts saving the selected items at the specified location.

   Note: You can stop the saving process by clicking the Stop Saving button or if you want to skip any file from saving, click the Skip File button.

After the saving process is completed, a dialog box displaying the “Files Saved Successfully” message appears.

12. Click the OK button to close the dialog box.

Now, you can view the recovered file(s) from the saved location.

### 4.2.2 Using the Extensive Scan Mode

The **Extensive Scan** mode is much advanced recovery mode than the Quick Scan mode. This mode effectively recovers files that are not recovered by the Quick scan mode. The deleted, lost, or corrupt folders are efficiently recovered using this mode. In addition, the data which has been lost due to the partitions deletion, partitions formatting, or partitions recreation is successfully recovered using this mode. Moreover, the files that were deleted long ago can also be recovered using this mode. The deleted files that are recovered using this mode will be displayed in Red color. Following steps help you to recover the lost data using the Extensive Scan mode:

1. Start the software.

2. Click the **Extensive Scan** icon. All Physical Device(s) and Logical Drive(s) available in your computer appear.

3. Select a drive under the Logical Devices node from which you want to recover the data. When you select the drive, information, such as volume name, capacity, etc. appears in the right panel.

   Note: By default, the software displays the current file system used in the partition, but if you think that the file system is different than displayed, then you can select the appropriate file system by clicking the drop-down arrow beside the Select File System drop-down list.
4. Click the **Next** button to start the searching process. The software starts searching for data in the selected device.

![Note:](#)

- Click the **Hide Progress** button to improve the performance of data searching and hide the progress information.
- Click the **Stop** button to stop the searching process anytime.

After the searching process is completed, all recoverable files get displayed in a tree-like structure in the left panel of the software window.

5. Select a folder in the left tree whose content you want to verify before saving. When you select the folder, its content gets displayed in the right panel.

6. Now, select an item in the right panel to preview the selected item. The software displays the preview of the selected item.

7. After previewing the required items, select them for saving and then click the **Recover** button. The “Browse for Folder” dialog box appears.

8. Specify a location to save the selected items and then click the **OK** button. The software starts saving the selected items at the specified location.

![Note:](#)

- You can stop the saving process by clicking the **Stop Saving** button or if you want to skip any file from saving, click the **Skip File** button.

After the saving process is completed, a dialog box displaying the “Files Saved Successfully” message appears.

9. Click the **OK** button to close the dialog box.

### 4.2.3 Using the File Trace Mode

The **File Trace** is a slow recovery mode, which searches for data in sectors of the partition. Using this recovery mode, you can select the file types whose data you want to recover. This mode takes more time than the Quick Scan and Extensive Scan modes but provides better results than the Quick Scan and Extensive Scan modes. Following steps help you to recover the lost data using the **File Trace** mode:

1. Start the software.

2. Click the **File Trace** icon. All Physical Device(s) and Logical Derive(s) available in your computer appear.

3. Select a drive under the Logical Devices node from which you want to recover the data. When you select the drive, information, such as volume name, capacity, etc. appears in the right panel.

4. Click the **Next** button.
5. Again click the **Next** button. The “File Types” dialog box appears prompting you to select the file types that you want to recover:

![Figure 4.14: File Trace Window](image)

6. Select the file types and click the **OK** button.

### Note:
The software also allows you to specify the file size. For example, if you want to search for the files whose maximum size is 4 MB then the software will not recover the files whose size will go beyond 4 MB. To specify the file size, select a value in the Select File Size drop-down list.

7. As you click the **OK** button, the software starts searching for the recoverable data.

### Note:

1. Click the **Hide Progress** button to improve the performance of data searching and hide the progress information.

2. Click the **Stop** button to stop the searching process anytime.

After the searching process is completed, all recoverable files get displayed in a tree-like structure in the left panel of the software window.
8. Select a folder in the left tree whose content you want to verify before saving. When you select the folder, its content will get displayed in the right panel.

9. Now, select an item in the right panel to preview the selected item. The software displays the preview of the selected item.

10. After previewing the required items, select them for saving and then click the **Recover** button. The “Browse for Folder” dialog box appears.

11. Specify a location to save the selected items and then click the **OK** button. The software starts saving the selected items at the specified location.

   **Note:** You can stop the saving process by clicking the **Stop Saving** button or if you want to skip any file from saving, click the **Skip File** button.

   After the saving process is completed, a dialog box displaying the “Files Saved Successfully” message appears.

12. Click the **OK** button to close the dialog box.

   **Note:** In this mode, deleted files are not displayed in Red color. Moreover, original file names are not recovered; therefore, files are named numerically in a proper sequence.

### 4.3 Preview Recovered Files

**Kernel for Windows Data Recovery** can recover every type of file from corrupt drive. The software recovers every file type and enables you to preview the recovered file(s). While previewing the selected file, you may get following message(s):

- **Select file for preview:** This message is displayed when the software prompts you to select the file to preview.

- **Preview not available for this file type:** This message is displayed when the preview of certain file type is not available. The software supports preview of certain recovered file types, which are mentioned below.

- **File Corrupted:** This message is displayed when the recovered file is corrupted. The software will not display preview of the file which is corrupt.

- **File too large to preview:** This message is displayed when file size of the recovered image or file is too large to preview. This does not mean that the image or file is not recovered; the file is recovered but software will not display its preview because it is too large to preview. The recovered file can be viewed when you save the recovered results.

Supported File Types for Preview are:
5. Understanding Other Useful Options

Kernel for Windows Data Recovery software is an output-driven utility that can even recover the file(s) or folder(s) that are deleted by pressing the SHIFT + DELETE key. Possessing an exceptional ability to recover data even from the deleted, formatted, and re-formatted partitions, there are few other important options that an individual needs to understand about this software like:

- Configure Software Settings
- Save Snapshot
- Load Snapshot
5.1 Configure Software Settings

Kernel for Windows Data Recovery software allows you to define the recovery settings. These settings can be defined at the beginning of the recovery process i.e. when you start the software. Following steps help you to configure software settings:

1. Start the software.

2. Select Tools > Settings. The “Recovery Settings” dialog box appears:

![Recovery Setting Window](Figure 5.1: Recovery Setting Window)

3. Define the settings as per your need and click the OK button. The software will then function according to the saved settings.

5.2 Save Snapshot

"Save the scanning process of the drive in Evaluation version and load it in Full version"

Kernel for Windows Data Recovery software enables you to save the scanning process of your corrupt hard drive. This facility helps you in terms of scanning the drive again and again. As Evaluation version of the software does not allow you to save the recovered files, the Save Snapshot option becomes helpful to users in such a case. You can upload the saved snapshot in Full version of the software to save the time of scanning the drive once again and to make the recovery process fast.
The **Save Snapshot** option is disabled by default. It will be enabled when the software has displayed the files that can be recovered. Once the software has displayed the files that can be recovered, execute the following steps to save the recovery snapshot:

1. Click the **Save Snapshot** button in the tool bar. The “**Save As**” dialog box appears:

![Save As Window](image)

2. Type a name for the recovery snapshot in the File name drop-down list.
3. Specify a location to save the snapshot.
4. Click the **Save** button to save the snapshot.

The snapshot will be saved in `.nkfn` format.

### 5.3 Load Snapshot

“Load the Saved Snapshot of the scanning process and save your precious time” is the aim of embedding the **Load Snapshot** feature in the software. The **Load Snapshot** feature saves the time of rescanning the selected drive for data recovery. Execute the following steps to load the saved snapshot:

1. Start the software.
2. Select a scanning mode. The “Load Snapshot” option will be active.
3. Select **Recovery > Load Recovery Snapshot** option. The “Open” dialog box appears:
4. Select the saved snapshot and click the Open button.

The software successfully loads the selected snapshot enabling you to continue the recovery process.

5.4 Find File(s)

During the recovery process, thousands of files are recovered. You may not need to save all files that are recovered. Therefore, in order to help you find a specific file or the files based on a specific file type from thousands of the files recovered, the **Find File(s)** feature has been embedded in the software. Following steps help you to use the **Find File(s)** option:

1. Select **Tools > Find Files** option. The “Find Files” dialog box appears:
2. Type the file name or the file type in the “Enter pattern to search” text box. For example, if you want to search only documents then type *.doc in the text box.

3. Click the **Start Search** button. The software starts searching for the available files amid recovered files.

4. After the software has displayed the files, select the files that you want to save and click the **Save Selected File** button to save the selected file(s).

**Note:** Click the **Stop Search** button to stop the searching process in between.

### 5.5 File Filters

The **File Filters** option works similar to the **Find File(s)** option. The only difference is, using the File Filters option you can specify multiple file types while using the Find File(s) option only one file type can be specified.

For example, you want to search files having .doc, .jpeg, and .xls formats then you add these extensions to the File Filters dialog box and the software will then display the files related to the specified patterns. Following steps help you to use the File Filters option:

1. Select **Tools > File Filters**. The “File Filters” dialog box appears:
2. Type a search pattern in the “Enter Filter” dialog box and click the Add button.

3. Repeat step 2 to add multiple search patterns.

4. Click the Close button after you have added all search patterns.

Note: Click the Remove button to remove the selected search pattern from added patterns.

5.6 Drive Information

Kernel for Windows Data Recovery also provides you detailed information about the drives available in your computer. In order to view drive information, select Tools > Drive Information. The software displays the information about the drives available:

After you have seen the drive information, click the OK button to close the dialog box.
6. Download Purchase and Register

One can use Kernel for Windows Data Recovery evaluation version for free and experience the capabilities of the software, but there are certain features that are not available in the evaluation version. In order to experience all the features of the software one has to purchase the complete and licensed version of Kernel for Windows Data Recovery software. As soon the purchase transaction with our resellers gets completed, our sales team will send you an email comprising the URL to download the full version of Kernel for Windows Data Recovery software and its activation details.

6.1 Free Trial Download

The trial version of Kernel for Windows Data Recovery software is also available, with which you can evaluate and analyze the capabilities of the software. The trial version of the software works similar to the Full version except allowing you to save the recovered files and folders. However, the trial version enables you to save the recovered items in the form of a snapshot, which can be loaded later with the Full version. Saving the recovered items as snapshot saves your time of rescanning the drive after purchasing the Full version.

6.2 Purchase and Register

You must purchase Full version of Kernel for Windows Data Recovery software in order to save the recovered files and folders. The FREE trial version of the software allows you to preview the recovered items but does not allow saving them. Therefore, to save the recovered items, you need to purchase the software.

You can purchase the software through Lepide Software website:


Payment and Delivery

Purchase the Kernel for Windows Data Recovery software from our authorized resellers, which provide number of payment options for your ease - PayPal, FAX, Credit Card, E-cheque, Pay Order, etc.

After making the purchase transaction with our resellers, we send you an email, which consists of activation details and download link of the Full version comprising of the activation code. This email is sent to the email address, which you have used while processing the purchase transaction with our resellers.

We suggest you not to use false e-mail address while making the purchase transaction

For any other details related to purchase process, software activation process, email us at:

sales@nucleustechnologies.com
6.3 Support

We have an extensive and efficient support system in place to assist our customers with all issues related to using Kernel for Windows Data Recovery. The software comes with an embedded help manual that can be accessed by clicking Help→Contents in the menu-bar. You can also press the F1 key on the keyboard of your computer to access the embedded help of Kernel for Windows Data Recovery.

You can access the online help for Kernel for Windows Data Recovery at: http://www.nucleustechnologies.com/Online-Helps.html

We also have live support wherein you can chat with our software experts at: http://www.nucleustechnologies.com/Support.html.

To talk on phone with our software experts call:

**Helpline:**

+91-9818725861

1-866-348-7872 (Toll Free for USA/CANADA)

You can also email us about your queries at:

sales@nucleustechnologies.com for Sales

support@nucleustechnologies.com for Support

contact@nucleustechnologies.com for General Queries
7. Legal Notices Legal Notices

This section comprises the legal specification about Kernel for Windows Data Recovery and the company LEPIDE SOFTWARE PRIVATE LIMITED

7.1 Copyright Notice

Lepide Software Private Limited, Kernel for Windows Data Recovery, accompanied user manual, and documentation are copyright of Lepide Software Private Limited, with all rights reserved. Under the copyright laws, this user manual cannot be reproduced in any form without the prior written permission of Lepide Software Private Limited. No Patent Liability is assumed, however, with respect to the use of the information contained herein.

7.2 Trademarks

Kernel for Windows Data Recovery ® is a copyright work of Lepide Software Private Limited


All other brand and product names are trademarks or registered trademarks of their respective companies.

7.3 Disclaimer

The Information contained in this manual, including but not limited to any product specifications, is subject to change without notice. Lepide Software Private Limited provides no warranty with regard to this manual or any other information contained herein and here by Expressly disclaims any implied warranties of merchantability or fitness for any particular purpose with regard to any of the foregoing Lepide Software Private Limited assumes no liability for any damages incurred directly or indirectly from any technical or typographical errors or omissions contained herein or for discrepancies between the product and the manual. In no event shall Lepide Software Private Limited, be liable for any incidental, consequential special, or exemplary damages, whether based on tort, contract or otherwise, arising out of or in connection with this manual or any other information contained herein or the use there of.

7.4 License Agreement

Kernel for Windows Data Recovery Copyright © by Lepide Software Private Limited

Your Agreement to this License

You should carefully read the following terms and conditions before using, installing, or distributing this software, unless you have a different license agreement signed by Lepide Software Private Limited. The terms and conditions of this License describe the permitted use and users of each Licensed Copy of Kernel for Windows Data Recovery. For purposes of this License, if you have a valid license, you have the right to use a single Licensed Copy of Kernel.
Scope of the License

Each Licensed Copy of Kernel for Windows Data Recovery may either be used by a single person or used non-simultaneously by multiple people who use the software personally installed on a single workstation. All rights of any kind in Kernel for Windows Data Recovery, which are not expressly granted in this License, are entirely and exclusively reserved to and by Lepide Software Private Limited. You may not rent, lease, modify, translate, reverse engineer, decompile, disassemble, or create derivative works based on, Kernel for Windows Data Recovery, nor permit anyone else to do so. You may not make access to Kernel for Windows Data Recovery available to others in connection with a service bureau, application service provider, or similar business, nor permit anyone else to do so.

Warranty Disclaimers and Liability Limitations

Kernel for Windows Data Recovery, and any and all accompanying software, files, data and materials, are distributed and provided as is and with no warranties of any kind, whether expressed or implied. In particular, there is no warranty for the quality of data recovered. You acknowledge that good data processing procedure dictates that any program, including Kernel for Windows Data Recovery, must be thoroughly tested with non-critical data before there is any reliance on it, and you hereby assume the entire risk of all use of the copies of Kernel for Windows Data Recovery covered by this License. This disclaimer of warranty constitutes an essential part of this License. In addition, in no event does Lepide Software Private Limited authorize you or anyone else to use Kernel for Windows Data Recovery in applications or systems where Kernel for Windows Data Recovery failure to perform can reasonably be expected to result in a significant physical injury, or in loss of life. Any such use is entirely at your own risk, and you agree to hold Lepide Software Private Limited harmless from any and all claims or losses relating to such unauthorized use.

General

This License is the complete statement of the agreement between the parties on the subject matter, and merges and supersedes all other or prior understandings, purchase orders, agreements, and arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction and venue for all matters relating to this License shall be in courts and for a located in the State of Delhi, and you consent to such jurisdiction and venue. There are no third party beneficiaries of any promises, obligations, or representations made by Lepide Software Private Limited herein. Any waiver by Lepide Software Private Limited of any violation of this License by you shall not constitute, nor contribute to, a waiver by Lepide Software Private Limited of any other or future violation of the same provision, or any other provision, of this License.